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NWN ScriptEase Tutorial

ScriptEase is a program that complements the Aurora toolset and helps you bring your
story to life. It helps you to weave the plot into your story and make it more interesting
for the reader/player. We will continue to build on the short story Lost Grandmother as
we go through this tutorial. The order in which the story is built is not necessarily
chronological, as some plot elements are easier to create than others. This is why it is a
good idea to know the main conflict and general plot structure of your story before you
start.

Patterns
ScriptEase works by using something called patterns. The main pattern you will use is the

Encounter pattern, which is represented on your screen by the E symbol .  When
creating an encounter pattern you have to specify the type of Encounter you wish to use.
Options for Encounter types include:

• Triggers
• Placeables
• Containers
• Conversations
• Doors
• Items
• Transitions
• Creatures

We will try out almost all of these Encounter types as we go through the ScriptEase
Tutorial. Let’s get started.

Tutorial 1: Acquire Potion Gain XP
Once you create an encounter and set its parameters, ScriptEase creates scripts that
bring to life the directions you have provided. In this first tutorial, we are going to create
an Encounter that when you pick up a potion on the exterior grounds of the castle, you
automatically receive experience points (XP). This is important to our story since XP
enable characters to move up levels and as a result become more advanced. First, we need
to start up ScriptEase.

1. Double click on the ScriptEase icon located on your desktop.
2. From the file menu select Open Module.
3. Browse to the modules folder and open the CastleEmpty.mod you were previously

working with.

Name: _____________________________ Date: ________________
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The ScriptEase Program window is set up similar to a Windows Explorer window. You will
notice the top part of the window is the “explorer section” where all of the folders
regarding your short story module are displayed. For now you just have 1 folder –
CastleEmpty.mod. By adding encounters into this main folder you are adding plot elements
and details to your story.

1. Right-Click on the CastleEmpty.mod folder and select New-Specific Encounter |
Items | Award XP for acquired item.

2. In the bottom grey window click the Acquired Item tab.
3. Use the pick button to find the Potion of Cure Moderate Wounds you created in the

toolset.

4. Left-click on the potion and click ok.
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5. In the grey window click the XP Awarded tab.
6. Change the constant 0 to 100.
7. Choose the Save Module and Compile option from the file menu and try picking up

the potion in the game to see what happens.

Exercise 1
A. Set it up so that when a player picks up the 50 gold pieces in the castle they are

awarded 250 XP.
B. Script it so that a player may sit on one of the chairs in room 1. HINT: chairs are

placeables.
* Try out the changed game!!

Tutorial 2: Disturb Statue – Unlock Door
Within an Encounter that you have created there will be one or more situations

automatically created represented by the symbol S .  Situations enable you to make
your story more complex. Sometimes there will be situations created that you don’t need.
These are there because of the philosophy it’s easier to delete rather than recreate. The
Encounter we are creating in tutorial 2 relates to solving a puzzle. The main character
must remove a book called the “Origin of Magic” from a statue before a door in the castle
will unlock and allow the character to go through and continue with their search of the
castle.

1. Open the CastleEmpty.mod you were previously working with.
2. Right-Click on the CastleEmpty.mod folder and select New-Specific Encounter |

Containers | Container Disturb – (specific item) toggle door.
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3. In the grey window, under the description tab change the Instance Name to
Disturb Statue – Open Door.

4. In the grey window click the Container tab.
5. Use the pick button to find the Statue you created in the toolset.

6. Left-click on the Statue and click OK.
7. In the grey window click the Specific Item tab.
8. Use the pick button to find the Origin of Magic book you created in the toolset.
9. Left-click on the book and click OK.
10. In the grey window click the Door tab.
11. Use the pick button to find halltolibrary under Universal | Wood
12. Left-click on the halltolibrary door and click OK.
13. Expand the Disturb Statue – Open Door menu in the top window and right-click on

Add Specific Item. Select Delete.



5

14. Right-click on Steal Specific Item and select Delete.
15. Choose the Save Module and Compile option from the file menu and try just opening

the door. Then restart the game and this time remove the book from the statue
and then try the door.

Exercise 2
A. Set it up so that when a player adds the Origin of Magic book (“container disturb”)

to the empty statue, Spidy appears (“spawn creature”) and attacks the player.
(HINT: You don’t need to specify the item you are going to add in ScriptEase).

* Try out the changed game!!

Tutorial 3: Use Door – Spawn Creature
Situations within Encounters can become even more complex. Situations will always contain

one Event represented by the symbol . They also may include one or more actions

represented by the symbol . You are once again able to create more and more depth to
your story. In this tutorial a creature will be created when you open a certain door in the
castle. This is just another one of the many challenges the granddaughter will face when
searching the castle. An example of what part of your screen should look like when you
have finished tutorial 3 is displayed below.
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1. Open the CastleEmpty.mod you were previously working with.
2. Right-Click on the CastleEmpty.mod folder and select New-Specific Encounter |

Doors | Door Use.
3. Under the description tab change the Instance Name to Use roomtobedroom door.
4. In the grey window click the Door tab.
5. Use the pick button to find the roomtobedroom door you created in the toolset.
6. Left-click on the door and click OK.

7. Expand the Encounter menu. Right-click on Door Close – add actions and select
Delete.

8. Right-click on Door Lock – add actions and select Delete.
9. Right-click on Door Unlock – add actions and select Delete.
10. Right-click on Door Open Failed – add actions and select Delete.
11. Left-click on the Situation Door Open – add actions.
12. In the grey window click the Plot tab.
13. Select the radio button “Yes run it only the first time the conditions are satisfied”.
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14. Expand the Door Open – add actions menu.
15. Right-click on the Door Open Situation.
16. Highlight Add an Action | Action Atom | Object Creation | Spawn a Creature near

an object.

17. Right-click on Replace this action… and select Delete.
18. Highlight the Action line “Spawn Spawned Creature…”
19. In the grey window click the Creature Blueprint tab.
20. Use the pick button to find the skeleton “Rattle” you created in the toolset.
21. Left-click on the skeleton and click OK.
22. In the grey window click the Target tab.
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23. Click the "Select Object" radio button and choose "The Door"
24. Choose the Save Module and Compile option from the file menu and try just opening

the door. Then restart the game and this time remove the book from the statue
and then try the door.

Exercise 3
A. Add an action to the Encounter Use Chair – Sit | Situation Sit so that when the PC

sits an ACTION - one-liner conversation occurs. Use the chairconversatio.dgl file.
B. Set it up so that when the roomtobedroom door is closed the Bedroom Chest

appears in the bedroom. (HINT: You are creating a placeable near an object and the
target for the object is the waypoint Chest Creation).

C. Create a “Container Use” Encounter so that when the book is removed the statue
speaks (Enter text in Constant field) and lets the PC know to put the book into the
other statue. *PLEASE NOTE: This is text you are entering from the keyboard not
a conversation file that was created earlier.

D. Create an Container Open/Dead Encounter so that the Grandson NPC is “spawned”
near “Grandson’s Chair” when Greendude is defeated.

* Try out the changed game!!

Tutorial 4: Bedroom Door provides Hint of Bedroom Chest
Tutorial 4 sets up another puzzle for the main character and provides a hint of a hidden

chest. This tutorial also introduces Definitions represented by the symbol  and

conditions represented by the symbol . Definitions allow you to specify details related
to the story that you need to use in the specific Encounter you created. For example, they
can be used to find out if a character has an item in its possession. Conditions then allow
you to carry out actions based on whether the definition is positive or negative, true or
false, yes or no etc. An example of what part of your screen should look like when you have
finished tutorial 4 is displayed below.
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1. Open the CastleEmpty.mod you were previously working with.
2. Right-Click on the CastleEmpty.mod folder and select New-Specific Encounter |

Triggers | Trigger enter – show object monologue.

3. Under the description tab change the Instance Name to Enter Bedroom Door –
Provide Hint.

4. In the grey window click the Trigger tab.
5. Use the pick button to find the Conversation Trigger under Generic Trigger.
6. Left-click on the trigger and click ok.
7. In the grey window click the Object tab.
8. Use the pick button to find the roomtobedroom door.
9. Left-click on the door and click OK.
10. In the grey window click the Conversation tab.
11. Use the pick button and select doorconversation.dlg. Click OK.
12. Expand the Trigger Enter situation.
13. Right click on the Trigger Enter situation.
14. Highlight Add a Definition | Binary | Testing Creature/Placeable Properties |

Whether a creature/placeable has an item.
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15. In the grey window click the Owner tab.
16. Click the Select Container radio button.
17. Use the drop down menu to pick “The Enterer”.
18. In the grey window click the Item tab.
19. Use the pick button to find the Origin of Magic Book.
20. Right-click the Situation "Trigger Enter - show object monologue" and click Add

Condition | If positive.
21. Click the "Definition" tab and then the "Select Binary" radio button.
22. Use the drop down menu to select Has Item.
23. Highlight the Action line “Object* starts a conversation…”
24. In the grey window click the Partner tab.
25. Select Enterer from the drop down menu.

26. Choose the Save Module and Compile option from the File menu and try just opening
the door. Then restart the game and this time make sure you are in possession of
the book before opening the door.
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Exercise 4
A. Create an Container Open/Dead Encounter called Defeated Spidy. Arrange it so

that when Spidy dies the PC is given 1500XP. This enables them to go up a level. You
need to define The PC as PC, in order for it to work.

B. Set it up so that when the player puts on the amulet in room 5 and then steps into
room 5B Norbert is “spawned”. (HINT: you need to use Trigger Enter – spawn
creature near object, where your trigger and your target is Room 5B trigger and
you need to create a new definition by Add a Definition | Binary | Testing
Creature/Placeable Properties | Whether a creature has an item equipped in an
inventory slot, that checks whether “the item is equipped” in other words whether
the Enterer has the amulet around their NECK.) (Plot – Yes, only first time…)

* Try out the changed game!!

Tutorial 5: Conversation with Mr. Greeting
A short story needs to have conversation amongst the characters in order for the story to
make sense. When a person is reading a short story they read every line. However, in the
interactive short story we are creating we must guide our characters in order for the plot
events to unfold. We use conversations to provide hints to the characters about what to
do next. ScriptEase allows you to do a little bit more with conversations including:
displaying certain text based on conditions you set up such as checking whether the
character has a certain possession. In this tutorial, you will set up a specific conversation
with Mr. Greeting only if the character has the Potion of Cure Moderate Wounds in their
possession. An example of what part of your screen should look like when you have finished
tutorial 5 is displayed below.
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1. Open the CastleEmpty.mod you were previously working with.
2. Right-Click on the CastleEmpty.mod folder and select New-Specific Encounter |

Conversations | Basic Conversation.
3. Under the description tab change the Instance Name to Conversation with Mr.

Greeting.
4. In the grey window click the Conversation Node tab.
5. Use the pick button to find the Conversation mrgreetinghint.dlg.

6. Left-click on the conversation.
7. Select the FIRST OWNER line. (“Hello <FirstName> welcome to the castle”) and

click ok.

8. Expand the Encounter menu.
9. Right-click on the Situation “These actions will…” and select Delete.
10. Expand the Situation menu.
11. Right click on the Condition “Always positive…” and select Delete.
12. Right click on the situation “Whether this conversation…” select Add a Definition |
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Binary | Testing Creature/Placeable Properties | Whether a creature/placeable has
an item.

13. In the grey window click the Owner tab.
14. Click the Select Container radio button and choose PC Speaker from the dropdown

menu.
15. In the grey window click the Item tab.
16. Use the pick button to locate the Potion of Cure Moderate Wounds under

Miscellaneous | Potions.
17. Right click on the situation “Whether this conversation…” select Add a Condition |

If Positive.
18. In the grey window click the Definition tab.
19. Click the Select Binary radio button.
20. Use the drop down menu to select Has Item.
21. Choose the Save Module and Compile option from the file menu and try talking to

Mr. Greeting. Then leave the castle and obtain the Cure potion. Reenter the castle
and talk to Mr. Greeting again to see the difference.

Exercise 5
A. Set up a basic conversation with the Dragon – Norbert ONLY IF the PC is

WEARING the amulet. The conversation was created previously and is called
norbert.dlg. (Plot – Yes, only the first time…)

B. Set up a basic conversation with the Maid using the “bookhint.dlg” Conversation
Node. Also arrange it so that the maid gives the PC their potion of invisibility.
(HINT: this is an ACTION).

* Try out the changed game!!

Tutorial 6: Barriers
As mentioned before, when a reader is reading a story it is easy to have them follow your
desired path. With the game story we want to be able to stop the character from going
certain places until plot events have unfolded. This tutorial shows you one example of
blocking the character from going into a certain room. The character must obtain an item –
sword, before the barrier disappears. An example of what part of your screen should look
like when you have finished tutorial 6 is displayed below.
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1. Open the CastleEmpty.mod you were previously working with.
2. Right-Click on the CastleEmpty.mod folder and select New-Specific Encounter |

Triggers | Trigger Enter/Exit - Barrier.

3. In the grey window, under the description tab change the Instance Name to
Storage Room (Barrier).

4. In the grey window click the Trigger tab.
5. Use the pick button to find the Barrier Trigger under Custom Palette | Generic

Trigger. Once you have Barrier Trigger selected click OK.
6. In the grey window click the Center tab.
7. Use the pick button to find the Barrier Waypoint under Custom Palette |

Waypoints. Once you have Barrier Waypoint selected click OK.
8. In the grey window click the Touch Effect tab.
9. Ensure the Constant radio button is pressed. Select Globe Use.
10. In the grey window click the Destroy Effect tab.
11. Ensure the Constant radio button is pressed. Select Dispel.
12. In the grey window click the Bounce Distance tab.
13. Ensure the Constant radio button is pressed. Type 2.5.
14. In the grey window click the Caption tab.
15. Ensure the Constant radio button is pressed. Type “YOU MUST OBTAIN THE

SWORD TO GAIN PASSAGE”.



15

We have now set up the encounter. However, we must add a Definition and a Condition in
order to make sure the character is in possession of the sword to pass through. If you
would like, try out the game to see what happens when you try to go into the storage room.

16. In the main window, right-click on Try to Exit Trigger and select Delete.
17. In the main window, right-click on Destroy barrier on entry and select Delete.
18. In the main window, right-click on Destroy barrier on exit and select Delete.
19. Expand the Situation menu. Right click on Situation (Try to enter trigger) and

choose Add a Definition | Binary | Testing Creature/Placeable Properties |
Whether a creature/placeable has an item.

20. In the grey window, click the Owner tab.
21. Ensure the Select Container radio button is pressed and choose Enterer from the

drop down menu.
22. In the grey window, click the Item tab.
23. Use the pick button to select Weapons | Bladed | Short Swords | Short Sword of

Quickness. Click OK.
24. Right-click again on situation and choose Add a Condition | If negative
25. In the grey window click the Definition tab.
26. Ensure the Select Binary radio button is pressed. Select Has Item from the drop

down menu.
It is now scripted so that if the character does not have the sword (If negative) then the
barrier will go off.  Try adding an ACTION so that when a person does try to enter the
barrier without the sword they take damage.



16

Exercise 6
A. Create a barrier in the doorway of the 3rd bedroom in the long hall (numbered 13 in

the previous tutorial). Use the try to enter barrier situation as well as the use the
Destroy barrier on entry Situation so that if the enterer has the skeleton key they
are granted passage. Use also the Room 13 Trigger and Waypoint created in the
previous tutorials.

Tutorial 7 - Introduction to Plot Tokens
This tutorial introduces you to a unique feature of ScriptEase – plot tokens.

Plot tokens are invisible items that are given or taken away, when certain actions occur.
Later in the game, you can test which plot tokens the character has, to determine what
should happen next. They are very useful for tying plot events together. In our case, we
want to give our main character a plot token when they defeat the boss monster.  The
castle will not be safe for your Grandmother until you have this plot token.

Most objects in the game can be destroyed.  When these objects are destroyed, the
"death" event occurs.  This can be useful when you'd like to move the plot forward once
the main character has killed an enemy.

An example of what part of your screen should look like when you have finished tutorial 7
is displayed below.

1. Open the CastleEmpty.mod you were previously working with.
2. Right-Click on the CastleEmpty.mod folder and select New-Specific Encounter |

Container Open/Dead.
3. In the grey window, under the description tab, change the Instance Name to "Boss

Defeated".
4. In the grey window, click the Container tab.
5. Click "Pick…" and choose "Hot Stuff" from the menu.  Click ok.
6. Right-click on the "Open container" situation and choose Delete.
7. Expand the "Dead container" Situation and delete the "action placeholder".
8. From the Tools menu at the top of the window select Plot Token Builder.
9. Right click in the white window and choose "New Plot Token".
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10. In the Token Name field name the Plot token “DefeatHotStuff”.
11. Click the X to close the window.
12. Right-click on the Dead container situation and Add an Action | Action Atom | Plot |

Assign a plot token to an object.
13. In the grey window click the Plot Token tab.
14. Ensure the Constant Radio button is pressed. Select "DefeatHotStuff" from the

drop down menu.
15. In the grey window click the Recipient tab.
16. Ensure the Select Object Radio button is pressed. Select Killer from the drop down

menu.

Now you have created a plot token which is given to the character once the final monster
is defeated.  When you have that plot token, all the monsters have been killed, so you can
safely bring your grandmother out from the bedroom.  We'll do this by making a new part
of the conversation available.  Here's an image of what you should see when you're done:

1. Right click "CastleEmpty.mod" and click "New Specific Encounter | Conversations |
Basic Conversation".

2. In the Description tab, change the Instance Name to "Grandmother - After
Defeating Hot Stuff".

3. In the "Conversation Node" tab, click "Pick…", then click "grandmother.dlg", and on
the right side, highlight "All of the monsters have been killed, everything's ok now."

4. Click ok.
5. Expand "Grandmother - After Defeating Hot Stuff".
6. Expand "Whether this conversation node is displayed".
7. Delete "Always Positive".
8. Right click "Whether this conversation node is displayed", then click "Add

Definition | Binary | Plot | Whether an object owns a plot token".
9. On the "Owner" tab, click "Select Object" and choose "PC Speaker".
10. In the "The Token" tab, click "Constant" and choose "DefeatHotStuff".
11. Delete the situation "These actions will be performed" by right-clicking it and

choosing delete.

Now we have allowed you to access a new part of the conversation.  We will now make the
module end when your Grandmother asks you to tea.  Here's an image of what you should
see when you're done:
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12. Right click "CastleEmpty.mod" and click "New Specific Encounter | Conversations |
Basic Conversation".

13. In the Description tab, change the Instance Name to "End Module".
14. In the "Conversation Node" tab, click "Pick…", then click "grandmother.dlg", and on

the right side, highlight "Sure grandmother, you lead the way."
15. Click ok.
16. Expand "End Module".
17. Delete "Whether this conversation node is displayed".
18. Expand the "These actions will be performed" item.
19. Delete the placeholder action.
20. Right-click the "These actions will be performed" item.  Click "Add an Action |

Action Atom | Game Control | End the module."

Now play what you've created!

Exercise 7
A. Try creating a new encounter that displays a visual effect when Hot Stuff is

killed.  There are many different effects you can try.
B. If you have extra time, you can create items that your grandma will give you

before you fight the last monster, to give your character an advantage.  You
can also customize your monster.  These will require you to make changes in
the Aurora toolset as well as ScriptEase.


